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Tableau Certified Data Analyst 38 X TDA-C01 & 5k 5 /& (Q114-Q119):

R #114

You have two tables named Employeelnfo and DepartmentInfo. Employeelnfo contains four fields named Full Name, Department
ID, Start Date, and Salary.

DepartimentInfo contains four fields named Department Name, Size, Department ID, and VP.

You want to combine the tables to meet the following requirements:

. Each record in Employeelnfo must be retained in the combined table.

. The records must contain the Department Name, Size, and VP fields.

Every record must have a full name.

Which type of join should you use?

A. Union

B. Full outer
C. Left

D. Inner

Ef: C

R -

To combine the tables and meet the requirements, you should use a left join. A left join will keep all the records from the left table
(Employeelnfo) and match them with the records from the right table (DepartmentInfo) based on the common field (Department ID).
Ifthere is no matching record in the right table, the fields from the right table will be null. This way, you will retain all the records from
Enployeelnfo, and also include the Department Name, Size, and VP fields from DepartmentInfo. Every record will have a full name
because it is a field from the left table. A left join will look like this:

References:

Join Your Data - Tableau

Join Types in Tableau

R #115

You have the following dataset.

Reglon | Sales
Central 3501 240
East , , § 678 781
South $301.722
| Wesl 320458

Which Level of Detail (LOD) expression should you use to calculate tie grand total of all the regions?

A. {FIXED: [Region] SUM Sales}
B. {Fixed: [Region]: TOTAL Sales}
C. {FIXED: TOTAL (Sales)}

D. {FIXED: SUM Sales}

IEf@E: D

R -

The correct Level of Detail (LOD) expression to calculate the grand total of sales across all regions would be {SUM(Sales)}. The
FIXED expression is not needed here because we are not computing the sum at the level of each region, but rather the total sum
across all regions. The FIXED keyword is typically used to aggregate at a certain level regardless of the view.
https7/help.tableau.convcurrent/pro/desktop/en-us/functions_functions_tablecalculation. htn# TOTAL

M #116

You want to connect a Tableau workbook to a dataset in a Microsoft Excel spreadsheet.


https://www.passtest.jp/Tableau/TDA-C01-shiken.html

‘What should you do from Tableau Desktop?

A. From the Data menu select New Data Source

B. From the Data menu select Replace Data Source
C. Fromthe File menu select New

D. From the File menu select Import Workbook

Ef#: A

it

To connect a Tableau workbook to a dataset in a Microsoft Excel spreadsheet, you need to select New Data Source fiom the Data
menu. This will open the Connect pane, where you can choose Microsoft Excel as your data source and browse for your
spreadsheet file. You can then drag and drop your sheets or tables to join or union them in the data source page. Reference:
https:/help.tableau.com/current/pro/desktop/en-us/connect_basic.htm https:/help.tableau.com/current/pro/desktop/en-
us/connect_excelhtm

HM #117
You have a large data source that contains more than 10 million rows. Users can filter the rows by a field named Animal.
The following is a sample of the data.

| Animal
| Aardvark
| Angelfish

HAd DTE€TU
| Arctic Woll
Bear

You want to improve the performance of the views by including only animals of a particular type.
To which filter should you add the Type field on the worksheet?

A. Dimension filler

B. Table calculation filter
C. Context filter

D. Measure filter

EfE: C

B #118

You have the following dataset.

~Name o [ [ Region | Tableau_User_Name Sales
Kehvin Hendncks | North khiemaid com $455 89
Simone Westn | South swiemad com $806 GO
Valerie Martin West mg‘m-! com $12000 20
'ﬂ}rllas Chan East pCibemad com $12300

You [El to create a dashboard that will be fitered to show only data that is relevant to a specific Tableau user based on the
Tableau User Name field You need to create a boolean calculated field to place on the data source finer Which formula should you
use for the filter?

A. ISFULLNAMETableu USER NAME))=USERNAME()
B. NAME Tableau-USER-NAME)

C. NAMEUSERNAME()

D. USERNAME()=(Tableau USER_ NAME)

Ef#: B

B #119



T ETEKONEN. BFHEOIDA-COIRELFOVERZIILIOCL>TWBRIERbA>TWET, &
NoDLEDY —K—E s DBEMELZIRSEMR T 2088 Wiz, RiFE BB L - TDA-COIFRE W &
D, IXRTOY—KX—HBHLOEBEHF2HEHE BRI 2H&BHDOREL HETT. TDA-COIRBENRL L DALY
WESTETETEBECL->TWBZEEHEVDY $¥A. /-, TDA-COIRBREL H Y £ 3. TDA-CO1
RELBBCRBTEES.

TDA-CO17 R + 2% & https//www.passtest.jp/Tableaw TDA-CO1-shiken. html

FEALDHBEORBI I T EITH LB N> T3, TDA-COlAF A FOEBC v EHWHES
BMELTWET, TDA-COINRRAAL—FL Y FOREFCEZLOBERDH Y 4. Tableau TDA-COLNHIEH A Hit
WIE2ABEOA Y SA Y7 —A—BHD EFFT. B L T &5 5. b %73 Bt OTDA-COEE 2kt 5 B
T% F7. Tableau TDA-COIMEHE £ o L B RESISER2VLEEL T £+ Tableau TDA-COIM R 72
5, b EEINZCHEL 7. IEOHREHFEDE. b ERA M7 —EFHWIEBBFETDA-COIE
MuETF ARy I2aL—XEERL L. BHEOTDA-COIAE 7 X FEREEEERVWY—L R & DiFETs1E
LTWwEd,

BOEAREZE S, HHARMOT. 2— b AADOHLFELZL THR3DLEBHMS LWL, FEALDHBHEDOREREZ
FTETHLLBIERDIr> T2, TDA-COLF A FOEMC b EHWHEEZREL Tw & 3. TDA-CO1
NAANW—bL Y FORFFCEZLDOEERDY £ 7,

B¢ 351 D Tableau TDA-CO1: 5k O B fE &

B 24BEOA Y SA VT —H—BH Y ET. BTHIL T Sh 6. H4 ik EHEDTDA-COEE it %
BATEET., S LBUERESELZVWEBLTVWET.

o TDA-COlBLfEfRHI4E (1 TDA-CO17 A bR () TDA-COLEH RIS () [ www.xhs1991.com 14 5
2 [ TDA-COl % EETX V> o —FT& £ TTDA-COl7 7 7 —¥ 3>~

o ABOEMHITIE-RIE S L LTDA-COLN IS A A A B - 2 TDA-CO17 2 + S%5H IR T 2120 T=
www.goshiken.com&# 5 ¢ TDA-CO1 (v [1% R T X 7 > o — FTDA-COI:ABR R &

o EEEK 4 TDA-COIXT RSN E - A% A L —XTDA-CO17 A b Z%E | 100% A EDTDA-COIFRENE = (
www.it-passports.com ) % 5[ TDA-CO1 |##E L T, REER 2 BRTL 7> o—F L TL £ & WTDA-COI
7 A &R

e Tableau TDA-CO1x$ s P ¥ Tableau Certified Data AnalystH {5 23%F > T % [ ¢/ www.goshiken.com [1¢/ [1i& \ [
TDA-CO1 & BRITX 7> u—F¥ 3D HEL 1 b T T TDA-COLE MM

e TDA-COIFBSET X a v /S— [I TDA-CO17 A £ [ TDA-CO1 & #& FIRET S [ [ www.jpexam.com |4
A M TEH TDA-COl R & X 7 > v — FTDA-CO1 & #% 14

o TDA-CO1:RERRERE [1 TDA-CO1RIRE & % [ TDA-CO1E#EHEME (1 44 <> www.goshiken.com< T (
TDA-C01 ) #RE L. ERTKX > o—FL TLEZIWIDA-COl* v Y 78R

o BT 5-100% B H#E DO TDA-COL G BB -3 O M TTIETDA-CO1 7 A + &% (1 -¢- TDA-CO1
(e D A BRI RE 1E = www.mogiexam.com € € SRR /5 FTDA-COIZEB b L —Y > 7

o TDA-CO13ZEk b L — Y > 7 [ TDA-COItE#EMERE [ TDA-CO13ZEBk b L —Y > 7 o [ TDA-CO1 ] % f&
BTK v > o — F» www.goshiken.com «TH#EZ 3 % 72 1 TDA-CO11R & Bbt

o BBOEMITIE-RIE S L LTDA-COLX RS WA AB-E K 2 TDA-COL7 R +S3%#H 1459 <>
www.mogiexamcom [ T[] TDA-CO1 (%R L . BB TKX 7> o—FL TL 2 & WTDA-COIZE T E

o TDA-CO13Z B 5% [ TDA-COVEBE S (1 TDA-CO17 A b &El [ = www.goshiken.com [17> 5 w
TDA-COl D% #EL T ABER 2 &L Y>> m—FL TL 23 WTDA-COIME & fEE

o RET 5-100% 5% D TDA-COLxH i A A A B - T B D ¥4 7715 TDA-CO1 7 A h %5 [ w TDA-CO1 [
DEEBTKX Yy e—F (wwwxhs1991.com) THRZET 3723 TDA-CO17 A &R

¢ gymrevampbrands.com, www.stes.tyc.edu.tw, myportal.utt.edu.tt, myportal.utt.edu.tt, myportal.utt.edu.tt,
myportal.utt.edu.tt, myportal.utt.edu.tt, myportal.utt.edu.tt, myportalutt.edu.tt, myportal.utt.edu.tt, myportal.utt.edu.tt,
myportal.utt.edu.tt, myportal.utt.edu.tt, myportal.utt.edu.tt, myportal.utt.edu.tt, myportal.utt.edu.tt, myportal.utt.edu.tt,
myportal.utt.edu.tt, myportal.utt.edu.tt, myportal.utt.edu.tt, myportal.utt.edu.tt, myportal.utt.edu.tt, www.stes.tyc.edu.tw,
ncon.edu.sa, www.stes.tyc.edu.tw, www.taowang.com, www.stes.tyc.edu.tw, focusibfnet, Disposable vapes

BONUS! ! ! PassTest TDA-CO1X > 7" D —#i % Bl ¢ X 7 > o — F: hitps/drive.google.com/open?
id=1Ze26IvriUJdvGbAMv5uyl O7YF-L-VQaq


https://www.passtest.jp/Tableau/TDA-C01-shiken.html
https://www.passtest.jp/Tableau/TDA-C01-shiken.html
https://www.mogiexam.com/TDA-C01-exam.html
https://www.xhs1991.com/TDA-C01.html
https://www.pdc.edu/?URL=https%253a%252f%252fwww.passtest.jp%252fTableau%252fTDA-C01-shiken.html
https://www.it-passports.com/TDA-C01.html
https://www.northwestu.edu/?URL=https%253a%252f%252fwww.passtest.jp%252fTableau%252fTDA-C01-shiken.html
https://www.jpexam.com/TDA-C01_exam.html
https://bbs.pku.edu.cn/v2/jump-to.php?url=https%253a%252f%252fwww.passtest.jp%252fTableau%252fTDA-C01-shiken.html
https://www.mogiexam.com/TDA-C01-exam.html
https://opal-foundation.org/?s=TDA-C01%25e5%258f%2597%25e9%25a8%2593%25e3%2583%2588%25e3%2583%25ac%25e3%2583%25bc%25e3%2583%25aa%25e3%2583%25b3%25e3%2582%25b0+%25f0%259f%2594%25ae+TDA-C01%25e6%25a8%25a1%25e6%2593%25ac%25e8%25a7%25a3%25e8%25aa%25ac%25e9%259b%2586+%25f0%259f%25a7%25a5+TDA-C01%25e5%258f%2597%25e9%25a8%2593%25e3%2583%2588%25e3%2583%25ac%25e3%2583%25bc%25e3%2583%25aa%25e3%2583%25b3%25e3%2582%25b0+%25e2%258c%259a+%25e3%2580%2590+TDA-C01+%25e3%2580%2591%25e3%2582%2592%25e7%2584%25a1%25e6%2596%2599%25e3%2581%25a7%25e3%2583%2580%25e3%2582%25a6%25e3%2583%25b3%25e3%2583%25ad%25e3%2583%25bc%25e3%2583%2589%25e2%2596%25b6+www.goshiken.com+%25e2%2597%2580%25e3%2581%25a7%25e6%25a4%259c%25e7%25b4%25a2%25e3%2581%2599%25e3%2582%258b%25e3%2581%25a0%25e3%2581%2591TDA-C01%25e5%25be%25a9%25e7%25bf%2592%25e6%2595%2599%25e6%259d%2590
https://www.mogiexam.com/TDA-C01-exam.html
https://15klaptops.com/?s=TDA-C01%25e5%258f%2597%25e9%25a8%2593%25e6%2596%25b9%25e6%25b3%2595+%25f0%259f%2590%25bd+TDA-C01%25e6%25a8%25a1%25e6%2593%25ac%25e8%25a7%25a3%25e8%25aa%25ac%25e9%259b%2586+%25f0%259f%2595%25b3+TDA-C01%25e3%2583%2586%25e3%2582%25b9%25e3%2583%2588%25e8%25b3%2587%25e6%2596%2599+%25f0%259f%2590%258c+%25e2%259e%25a5+www.goshiken.com+%25f0%259f%25a1%2584%25e3%2581%258b%25e3%2582%2589%25e2%259e%25a5+TDA-C01+%25f0%259f%25a1%2584%25e3%2582%2592%25e6%25a4%259c%25e7%25b4%25a2%25e3%2581%2597%25e3%2581%25a6%25e3%2580%2581%25e8%25a9%25a6%25e9%25a8%2593%25e8%25b3%2587%25e6%2596%2599%25e3%2582%2592%25e7%2584%25a1%25e6%2596%2599%25e3%2581%25a7%25e3%2583%2580%25e3%2582%25a6%25e3%2583%25b3%25e3%2583%25ad%25e3%2583%25bc%25e3%2583%2589%25e3%2581%2597%25e3%2581%25a6%25e3%2581%258f%25e3%2581%25a0%25e3%2581%2595%25e3%2581%2584TDA-C01%25e5%2595%258f%25e9%25a1%258c%25e3%2581%25a8%25e8%25a7%25a3%25e7%25ad%2594
https://www.xhs1991.com/TDA-C01.html
https://gym.revampbrands.com/profile/stevegr156
http://www.stes.tyc.edu.tw/xoops/modules/profile/userinfo.php?uid=3855788
https://myportal.utt.edu.tt/ICS/icsfs/2896e739-9ffb-4e34-bee9-877d6ab56278.pdf?target=4a6ffbcf-12dc-4d9d-8a0a-c5de5fdaf046
https://myportal.utt.edu.tt/ICS/icsfs/4a00356c-16d9-4e4b-a234-274253d4633f.pdf?target=59ad0092-4c6b-4eac-9182-b88ffdebfee9
https://myportal.utt.edu.tt/ICS/icsfs/5183bc61-90f3-4ae7-a457-813e22965969.pdf?target=aec9a8ca-7d30-4d8b-ab0d-52c3a9941cdc
https://myportal.utt.edu.tt/ICS/icsfs/6b82b8a4-ace5-4e00-8ed5-9fbd4d2326b5.pdf?target=cb8feae5-ac3b-407b-b7c4-c0e708091295
https://myportal.utt.edu.tt/ICS/icsfs/8bbac78e-6147-401b-9ff8-21d886fbfc36.pdf?target=539b8c26-e559-490e-b49a-655aa0f4913d
https://myportal.utt.edu.tt/ICS/icsfs/92df52d1-b83c-4f16-84fe-a2975cd4a703.pdf?target=0731da36-e0b4-4130-a18f-71be7be9b4e1
https://myportal.utt.edu.tt/ICS/icsfs/9a2b11ff-f446-4954-9803-7620b54e56ab.pdf?target=44fea614-88ce-407c-af39-bf7bc6737ccb
https://myportal.utt.edu.tt/ICS/icsfs/ba848c17-f3f5-40ec-a384-45c7a07e6f55.pdf?target=270b6992-8323-43dd-90d1-85532fb8a059
https://myportal.utt.edu.tt/ICS/icsfs/c9b79c61-81d0-4919-bbfd-4302ea7826e8.pdf?target=a54aa8fc-f040-41f0-8787-b812d06eb846
https://myportal.utt.edu.tt/ICS/icsfs/d1a58605-b8df-42e0-b8da-7d5dddf86d84.pdf?target=3067a48b-7000-4509-847e-7b038a444964
https://myportal.utt.edu.tt/ICS/icsfs/27ae3e4a-91b8-4a4c-93d2-062f805ee8d3.pdf?target=dfd44b95-a023-4d11-9324-0ea31f4a9cdc
https://myportal.utt.edu.tt/ICS/icsfs/2ac5de7b-19a1-4fd4-8f28-140c009a4bac.pdf?target=dd0e8128-a134-42a2-a287-6b9de568e25e
https://myportal.utt.edu.tt/ICS/icsfs/65bdba4a-6f70-4d0a-9197-15316582756a.pdf?target=a65480ef-5a60-4857-88c5-e93b0364a4c3
https://myportal.utt.edu.tt/ICS/icsfs/6ee26d9e-9074-4404-84fe-7ad2d7c039a6.pdf?target=e944b69c-5f4a-4622-867f-bfe24331780f
https://myportal.utt.edu.tt/ICS/icsfs/ba3a43fa-a7cb-4286-813d-02ec38966271.pdf?target=397ec05d-517f-40e0-80c9-17e1ebbe5902
https://myportal.utt.edu.tt/ICS/icsfs/c3ce0f8a-4381-4dad-b00e-88d184c947aa.pdf?target=f7478b1e-a96e-4416-a3a9-1ecc8924f992
https://myportal.utt.edu.tt/ICS/icsfs/cf003481-39bd-4094-b7ae-945bfc2a0e0f.pdf?target=c087d52f-9a64-4da4-8357-641ed48e50eb
https://myportal.utt.edu.tt/ICS/icsfs/d5ed3580-1884-4dff-9917-03e830c67326.pdf?target=6680fe48-32f2-46c9-a5a7-610b5125a8e9
https://myportal.utt.edu.tt/ICS/icsfs/fa3b56d8-7ae5-4888-bd93-7ed60eb61bd6.pdf?target=0ff525fd-2041-4b98-8911-8f348a0df85d
https://myportal.utt.edu.tt/ICS/icsfs/fd21b9a1-8f0a-40f4-a121-92fefced6df3.pdf?target=b85221ef-a9f7-4fff-91e1-ad72b640a9f0
http://www.stes.tyc.edu.tw/xoops/modules/profile/userinfo.php?uid=3855895
https://ncon.edu.sa/profile/hugosha759
http://www.stes.tyc.edu.tw/xoops/modules/profile/userinfo.php?uid=3854670
http://www.taowang.com/home.php?mod=space&uid=15001
http://www.stes.tyc.edu.tw/xoops/modules/profile/userinfo.php?uid=3813556
https://focusibf.net/profile/maxgree700
https://frvape.com
https://drive.google.com/open?id=1Ze26IvriUJdvGbAMv5uy1O7YF-L-VQaq

